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iMOTION™ Modular Application Design Kit

About this document

Scope and purpose

This User Guide provides an overview of the evaluation board EVAL-M3-302F including its main features, key
data, pin assignments and mechanical dimensions.

EVAL-M3-302F is an evaluation board as part of the IMOTION™ modular application design kit (MADK). This
board features and demonstrates Infineon’s advanced motion control engine (MCE 2.0) technology for
permanent magnet motor drives over the full speed range.

The evaluation board EVAL-M3-302F was developed to support customers during their first steps designing
applications using permanent magnet motors via sensorless sinusoidal control.

The IMC302A contains two cores - the Motion Control Engine (MCE) and an additional microcontroller (MCU).
MCE support files and documentation will be available from the Infineon website. The MCU core-related CMSIS
pack can be downloaded from the KEIL IDE and this document does not cover those topics.

Intended audience

This User Guide is intended for all technical specialists who have a knowledge of motor control and high-power
electronics converters. The board is intended for use under laboratory conditions.

This board will be used during design in, for evaluation and measurement of characteristics, and proof of data
sheet specifications.

Note: PCB and auxiliary circuits are NOT optimized for final customer design.
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1 Important notice

Attention: The Evaluation Boards and Reference Boards as well as the information in this document are
solely intended to support designers of applications in evaluating the use of products from
Infineon Technologies for their intended applications.

Environmental conditions have been considered in the design of the Evaluation Boards and
Reference Boards provided by Infineon Technologies. The design of the Evaluation Boards
and Reference Boards has been tested by Infineon Technologies only as described in this
document. The design is not qualified in terms of safety requirements, manufacturing and
operation over the entire operating temperature range or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject
to functional testing only under typical load conditions. Evaluation Boards and Reference
Boards are not subject to the same procedures as regular products regarding returned
material analysis (RMA), process change notification (PCN) and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products, and are solely
intended for evaluation and testing purposes. In particular, they shall not be used for
reliability testing or production. The Evaluation Boards and Reference Boards may therefore
not comply with CE or similar standards (including but not limited to the EMC Directive
2004/EC/108 and the EMC Act) and may not fulfill other requirements of the country in which
they are operated by the customer. The customer shall ensure that all Evaluation Boards and
Reference Boards will be handled in a way which is compliant with the relevant requirements
and standards of the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this
document are addressed only to qualified and skilled technical staff, for laboratory usage,
and shall be used and managed according to the terms and conditions set forth in this
document and in other related documentation supplied with the respective Evaluation Board
or Reference Board.

It is the responsibility of the customer’s technical departments to evaluate the suitability of
the Evaluation Boards and Reference Boards for the intended application, and to evaluate
the completeness and correctness of the information provided in this document with respect
to such application.

The customer accepts that the Evaluation Boards and Reference Boards are not intended to
be used in life-endangering applications such as medical, nuclear, military, life-critical or
other applications, where failure of the Evaluation Boards and Reference Boards, or any
results from the use thereof, can reasonably be expected to result in personal injury.

The Evaluation Boards and Reference Boards and any information in this document is
provided "as is" and Infineon Technologies disclaims any warranties, express or implied,
including but not limited to warranties of non-infringement of third party rights and implied
warranties of fitness for any purpose, or for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the
Evaluation Boards and Reference Boards and/or from any information provided in this
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document. The customer is obliged to defend, indemnify and hold Infineon Technologies

harmless from and against any claims or damages arising out of or resulting from any use
thereof.

Infineon Technologies reserves the right to modify this document and/or any information
provided herein at any time without further notice.
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2 Safety precautions

Please note the following warnings regarding the hazards associated with development systems.

Table1 Safety precautions

Warning: The DC link potential of this board is up to 1000 Voc. When measuring
voltage waveforms by oscilloscope, high voltage differential probes must be used.
Failure to do so may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take
time to discharge after removal of the main supply. Before working on the drive
system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to
do so may result in personal injury or death. Darkened display LEDs are not an
indication that capacitors have discharged to safe voltage levels.

Warning: The evaluation or reference board is connected to the grid input during
testing. Hence, high-voltage differential probes must be used when measuring voltage
waveforms by oscilloscope. Failure to do so may result in personal injury or death.
Darkened display LEDs are not an indication that capacitors have discharged to safe
voltage levels.

Warning: Remove or disconnect power from the drive before you disconnect or
reconnect wires, or perform maintenance work. Wait five minutes after removing
power to discharge the bus capacitors. Do not attempt to service the drive until the bus
capacitors have discharged to zero. Failure to do so may result in personal injury or
death.

Caution: The heat sink and device surfaces of the evaluation or reference board may
become hot during testing. Hence, necessary precautions are required while handling
the board. Failure to comply may cause injury.

Caution: Only personnel familiar with the drive, power electronics and associated
machinery should plan, install, commission and subsequently service the system.
Failure to comply may result in personal injury and/or equipment damage.

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when
installing, testing, servicing or repairing the assembly. Component damage may result
if ESD control procedures are not followed. If you are not familiar with electrostatic
control procedures, refer to the applicable ESD protection handbooks and guidelines.

Caution: A drive that is incorrectly applied or installed can lead to component damage
or reduction in product lifetime. Wiring or application errors such as undersizing the
motor, supplying an incorrect or inadequate AC supply, or excessive ambient
temperatures may result in system malfunction.

Caution: The evaluation or reference board is shipped with packing materials that
need to be removed prior to installation. Failure to remove all packing materials that
are unnecessary for system installation may result in overheating or abnormal
operating conditions.

>R B B BB
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3 Introduction

The EVAL-M3-302F evaluation board is a part of the iIMOTION™ Modular Application Design Kit for drives
(IMOTION™ MADK). In order to run a motor, the mating power board is required to interface this evaluation
board.

The MADK platform is intended for use with various power stages with different control boards. These boards
can easily be interfaced through the 20-pin iMOTION™ MADK M1, or the 30-pin iMOTION™ MADK M3 interface
connector. This board is equipped with a 30-pin M3 connector and is intended for running a power factor
correction (PFC) and single motor control in parallel.

This evaluation board is designed to give comprehensible solutions of sensorless control of permanent magnet
motors over the full speed range. It provides Hall-sensor based or sensorless controls applying 3-phase and
type 3 of 2-phase modulation. PC interface is via a micro-USB connector, and the on-board debugger is
galvanically isolated. The PC interface provides a UART connection to the MCE as well as a serial wire debug
(SWD) channel to the MCU.

The EVAL-M3-302F evaluation board is available from Infineon. The features of this board are described in the
main features chapter of this document, whereas the remaining paragraphs provide information to enable the
customers to copy, modify and qualify the design for production according to their own specific requirements.

Environmental conditions were considered in the design of the EVAL-M3-302F, but the board is not qualified in
terms of safety requirements or manufacturing and operation over the entire operating temperature range or
lifetime. The boards provided by Infineon are subject to functional testing only.

Evaluation boards are not subject to the same procedures as regular products regarding returned material
analysis (RMA), process change notification (PCN) and product discontinuation (PD). Evaluation boards are
intended to be used under laboratory conditions by technical specialists only.

Figure 1 shows the evaluation board EVAL-M3-302F. This document explains the features and details of this board
as well as the control IC, IMC302A-F064.

Figurel Evaluation board EVAL-M3-302F
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4 EVAL-M3-302F main features

EVAL-M3-302F is an evaluation control board for motor control applications. The kit demonstrates Infineon’s
motion control IC technology.

Main features of the IMC302A-F064 motion control IC include:

e Dual core device with MCE and MCU connected via high speed serial link

e MCE (Motion Control Engine) as ready-to-use solution for variable speed drives

o Field-oriented control (FOC) for permanent magnet synchronous motor (PMSM)

e Space vector PWM with sinusoidal commutation and integrated protection features
e Current sensing via single or leg shunt

e Sensorless or Hall-sensor based operation

e Active boost or totem pole PFC control integrated

e Various serial communication interfaces (UART, 12C, SPI)

e Multiple motor parameter support

o Flexible host interface options for speed commands: UART, 12C, SPI, PWM or analog signal
e UL /CSA60730 certified (Class B)

¢ Additional microcontroller (MCU) based on Arm® Cortex® MO core

e 96/48 MHz clock, 128 /16 KByte Flash/SRAM

e RTC/ systick/ watchdog timer, fast interrupt controller

e Peripheral set targeting system control and communication

e High-speed serial link (JCOM) between MCE and MCU

e 3.3V (default) or 5V VDD power supply

e Scalable package options

The evaluation board characteristics:

e Complete kit for running any permanent magnet motor via sensorless sinusoidal control

e 3.3Vforon-board debugger is powered by USB interface and motor controller side is powered by power
board

e Micro-USB connector and on-board debugger isolated by digital isolator
e Capable of 3-phase and type 3 of 2-phase modulation

e MCE and MCU run in parallel and independently from each other

e Access to MCE via virtual COM port

e Access to MCU via SWD debug channel (Segger® J-Link light)

e RoOHS complaint

e PCBsizeis 65 x45mm
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4.1 Functional description

Figure 2 shows a typical block diagram of a motor control application using the IMC302A-F064. The IMC302A-F064
provides a built-in, closed loop and sensorless control algorithm using the unique flexible Motion Control Engine
(MCE) for permanent magnet motors, and additionally a boost or totem pole power factor correction (PFC). The
MCE™ consists of a collection of control elements, motion peripherals, a dedicated motion control sequencer
and internal memory to map internal signal nodes. IMC302A-F064 also employs a unique single shunt current
reconstruction circuit in addition to a leg shunt current sensing circuit to eliminate additional analog/digital
circuitry.

Power factor
correction

boost/totem pole

= Communication Scripting
= Additional safety Safety

IMC300 I ‘ ‘ Gate driver | |Power stage
iMOTION™ 3% HS
| UART |< MCE
| SPI/12C | < Motorcontrol
* Sensors PFC control
{ * Actuators Protection

GPIO C|>

Figure2  Typical application block diagram using IMC302A-F064
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4.2 IMC302A-F064 pinout description

The main part of the EVAL-M3-302F MADK control board is the IMC302A-F064 iMOTION™ motor control IC.
Figure 3 depicts the pinout of the IMC302A-F064 IC. IMC302A-F064 comes ina 12 mm x 12 mm 64-pin LQFP
package.
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Top View
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Figure3  Pinout of IMC302A-F064
The pin type is specified as follows:
e |— digital input
e O —digital output
e AIN —analoginput
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Table 2 lists the available pins of IMC302A-F064 with short descriptions. For more detailed information, please
refer to the datasheet or hardware user manual for iIMOTION™ IMC302A-F064 motor control IC.

Table 2 IMC302A-F064 pinout description

Pin name Type Pin no. Description

VDD Power 24,25,35,50 | Supply voltage

VSS Power 23,49 Ground

PWMUL 0 29 PWM output phase U low
PWMUH 0 30 PWM output phase U high
PWMVL 0 31 PWM output phase V low
PWMVH 0 32 PWM output phase V high
PWMWL 0 33 PWM output phase W low
PWMWH 0 34 PWM output phase W high

GK I 36 Motor gate kill input

VDC AIN 14 DC bus sensing input

IU/ISS AIN 18 Current sense input single shunt / phase

U

v AIN 15 Current sense input phase V
IW AIN 11 Current sense input phase W
REFU AO 17 Itrip phase U reference output
REFV AIN 16 Itrip phase V reference output
REFW AIN 10 Itrip phase W reference output
AHALL1+ AIN 10 Analog Hall sensor Inputl+
AHALL1- AIN 11 Analog Hall sensor Input1-
AHALL2+ AIN 16 Analog Hall sensor Input2+
AHALL2- AIN 15 Analog Hall sensor Input2-
HALL1 [o] 26 Digital Hall sensor Inputl
HALL2 [o] 27 Digital Hall sensor Input2
HALL3 10 28 Digital Hall sensor Input3
PFCGO o 44 PFC gate drive 0 output

PFCG1 0 43 PFC gate drive 1 (totem pole PFC) output
IPFC AIN 12 PFC current sensing input
IPFCREF AIN 21 PFC Itrip reference input
IPFCTRIP AIN 22 PFC Itrip current sensing input
VAC1 AIN 20 AC voltage sensing input 1
VAC2 AIN 19 AC voltage sensing input 2
PGOUT 0 42 Pulse output

NTC AIN 13 External thermistor input

LED 0] 41 Status LED

RXDO I 45 MCE UARTO receive input
TXDO 0] 46 MCE UARTO transmit output

User Guide 10 of 41 Revision 1.2
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AIN1 AIN 10 Analog input

AIN2 AIN 11 Analog input

AIN4 AIN 13 Analoginput

AINT AIN 16 Analoginput

AINS8 AIN 17 Analoginput

GPIO9 (o] 26 User configurable /0, digital

GPIO10 (o] 27 User configurable /0, digital

GPIO11 [o] 28 User configurable I/0, digital

GPIO12 10 37 User configurable I/0, digital

GPIO13 10 38 User configurable 1/0, digital

GPIO14 [o] 39 User configurable /0, digital

GPIO15 [o] 40 User configurable 1/0, digital

P0.8 10 51 Programmable 1/0

P0.9 10 52 Programmable I/0

P0.10 10 53 Programmable I/0

P0.11 [o] 54 Programmable I/O

P0.12 [o] 55 Programmable I/O

P0.13 10 56 Programmable I/0

P0.14/SWDIO 10 57 Programmable 1/0, or MCU SWD debug
interface data input / output

P0.15/SWDCLK I 58 Programmable I/O, or MCU SWD debug
interface clock input

P1.0 [o] 48 Programmable I/O

P1.1 10 47 Programmable I/0

P2.0 IO/AIN 3 Programmable 1/0, or MCU UARTO
receive input, or analog input

P2.1 I0/AIN 4 Programmable /O, or MCU UARTO
transmit output, or analog input

P2.2 [O/AIN 5 Programmable I/O, or analog input

P2.6 I0/AIN 6 Programmable I/0O, or analog input

P2.8 [O/AIN 7 Programmable I/O, or analog input

P2.10 [O/AIN 8 Programmable I/0, or analog input

P2.11 [O/AIN 9 Programmable I/O, or analog input

P4.0 10 59 Programmable I/O

P4.1 [o] 60 Programmable I/O

P4.2 [o] 61 Programmable I/O

P4.3 62 Programmable I/O

P4.4 63 Programmable 1/0, or MCU UART1
receive input

P4.5 64 Programmable I/0, or MCU UART1
transmit output
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P4.6 Programmable I/O
P4.7 2 Programmable I/O
4.3 EVAL-M3-302F board specifications

Table 3 depicts the key specifications of the evaluation board EVAL-M3-302F.

Table 3 EVAL-M3-302F board specifications
Parameters Values Conditions [ comments
Host interface (not isolated)
UART(TXD, RXD) 0-vDD UARTO,UARTO_A, UART1_A
AIN 0-VvDD Analog input
DIN 0-VvDD Digital input
DOUT 0-VvDD Digital output
Input
VDD ‘ 3.3V (default),5V Controller supply voltage
DC bus

DC bus scaling

8.20 counts/V

13.3 kQ resistor on control board,

DC bus sensing range 499.54 \V max and 2 MQ resistor on power board
Current feedback

Motor internal current feedback 1,3,6,12 Configured by MCEWizard
amplifier gain

Motor current sensing device 0 - VDD/Gain Single shunt resistor

Leg shunt resistor

Motor current Op-amp
configuration

Non-Inverting

Default setting

Motor current external 0.833

amplification gain

PFC current sensing device 0 -VDD/Gain

PFC current Op-amp configuration | Non-Inverting Default setting

PFC current external amplification | 0.923

gain

Resolution 12-bit PCB design may reduce the

resolution

Protections

NTC Temperature shutdown value

0- VDD (configured by
MCEWizard)

PCB characteristics

Material FR4, 1.6 mm thickness
Copper thickness =1 0z (35 um)
Dimension 65 mm x 45 mm
User Guide 12 of 41 Revision 1.2
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4.4 Pin assignment
Key information about the connections of the EVAL-M3-302F evaluation board is described below.

Table 4 provides the pin assignments of the iIMOTION™ MADK-M3 30-pin interface connector J1. This connector
is the interface to the power board.

Table 4 J1- iIMOTION™ MADK-M3 30-pin interface connector for control board

Pin No. Pin Details

1 PWMUH 3.3V compatible logic output for high-side gate driver-Phase U
2 GND Ground

3 PWMUL 3.3V compatible logic output for low-side gate driver-Phase U
4 GND Ground

5 PWMVH 3.3V compatible logic output for high-side gate driver-Phase V
6 +3.3V On board 3.3V supply

7 PWMVL 3.3V compatible logic output for low-side gate driver-Phase V
8 +3.3V On board 3.3 Vsupply

9 PWMWH 3.3V compatible logic output for high-side gate driver-Phase W
10 U+ Shunt voltage phase U

11 PWMWL 3.3V compatible logic output for low-side gate driver-Phase W
12 IU- Ground

13 GK Gate kill signal - active low when over current is detected

14 DCBSENSE DC bus positive voltage, scaled in 0-3.3 Vrange by a voltage divider
15 VTH Thermistor input

16 IV+ Shunt voltage phase V

17 IV- Ground

18 IW+ Shunt voltage phase W

19 IW- Ground

20 vCC Defined for 15V power supply (not used in this board)

21 PFCGO 3.3V compatible logic output for PFC gate driver0

22 GND Ground

23 PFCG1 3.3V compatible logic output for PFC gate driverl

24 +3.3V On board 3.3V supply

25 - Not used

26 DCBSENSE DC bus positive voltage, scaled in 0-3.3 V range by a voltage divider
27 VAC+ AC voltage inputl with high resistive input

28 VAC- AC voltage input2 with high resistive input

29 - Not used

30 IPFC- Shunt voltage for PFC

User Guide 13 0f 41 Revision 1.2
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The EVAL-M3-302F supports the use of both digital and analog Hall sensors. Table 5 includes the details of the
Hall sensor interface connector.

Table 5 J2- Hall sensor Input

Pin Name Pin name connectors

1 GND Ground

2 AHAL2- Analog Hall sensor Input2-

3 DHAL3/AHAL2+ | Digital Hall sensor Input3 or analog Hall sensor Input2+
4 DHAL2/AHAL1- | Digital Hall sensor Input2 or analog Hall sensor Input1-
5 DHAL1/AHAL1+ | Digital Hall sensor Inputl or analog Hall sensor Inputl+
6 +3.3V +3.3V power supply

The IMC300 series of dual core controllers is the most flexible solution in terms of application support. A large
number of pins is made available on pin headers supporting multiple customer-use cases.

Table 6, Table 7, Table 8, Table 9, Table 10 and Table 11 include the details of the respective signal pins for the
embedded microcontroller (MCU). Functionality of the pins is flexible and can be assigned via the respective
program running on the MCU. For details please refer to the IMC300 hardware reference manual.

Table 6 J3- MCU UARTO and SWD
Pin Name Pin name connectors
1 SWDCLK User serial debug clock
2 SWDIO User serial debug /O
3 +3.3V +3.3V power supply
4 GND Ground
5 GND Ground
6 +3.3V +3.3V power supply
7 RXDO_A MCU serial port, RXD
8 TXDO_A MCU serial port, TXD
Table 7 J4- iMOTION Link
Pin Name Pin name connector
1 SWDCLK User serial debug clock for MCU
2 SWDIO User serial debug /0 for MCU
3 +3.3V +3.3 V power supply
4 GND Ground
5 GND Ground
6 +3.3V +3.3V power supply
7 RXDO Reception of UARTO for MCE
8 TXDO Transmission of UARTO for MCE
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Table 8 J5- MCU 1/0 connection
Pin Name Pin name connector
1 P2.1 Programmable /O, or MCU serial port 0
2 P2.2 Programmable I/O
3 P2.0 Programmable /O, or MCU serial port 0
4 P2.6 Programmable I/O
5 P4.6 Programmable I/O
6 P2.8 Programmable I/O
7 P4.7 Programmable I/O
8 P2.10 Programmable I/O
9 GND Ground
10 P2.11 Programmable I/O
Table 9 J6- MCU I/0 connection
Pin Name Pin name connector
1 P1.1 Programmable I/O
2 P1.0 Programmable I/O
3 +3.3V +3.3V power supply
4 GND Ground
5 P0.13 Programmable I/O
6 P0.8 Programmable I/O
7 P0.12 Programmable I/O
8 P0.9 Programmable I/O
9 P0.11 Programmable /O
10 P0.10 Programmable /O
Table 10 J7- MCU 1/0 connection
Pin Name Pin name connector
1 P4.1 Programmable I/O
2 P4.2 Programmable I/O
3 P4.0 Programmable I/O
4 P4.3 Programmable I/O
Table 11 J9- MCU UART1
Pin Name Pin name connector
1 GND Ground
2 +3.3V VDD
3 RXD1_A MCU serial port 1, RXD
4 TXD1_A MCU serial port 1, TXD
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The Motion Control Engine (MCE) in the IMC300 can read and drive pins directly, and it also supports scripting.
Table 12 lists the MCE I/O pins that are made available. For functionality please refer to the Motion Control
Engine Software Reference Manual.

Table 12 J8- MCE GPIO pins
Pin Name Pin name connector
1 GPIO12 User configurable 1/0, digital
2 GPIO13 User configurable I/0, digital
3 GPIO15 User configurable I/0, digital
4 GPIO14 User configurable I/0, digital
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5 Getting started with EVAL-M3-302F

In order to run the motor system, a combination of the iMOTION™ MADK control board (EVAL-M3-302F) and the
matching MADK power board (with M3 connector) is required. The iIMOTION™ software tools, MCEDesigner and
MCEWizard, are also required to initially set up the system, as well as to control and fine-tune the system
performance to match users’ exact needs. This chapter provides more details on setting up the system and
getting started with the IMOTION™ MADK development platform.

The EVAL-M3-302F consists of several functional groups, which enable an out-of-the-box, fully functional motor
control system combined with additional interfaces and test points for more advanced use cases. Figure 4
shows the functional groups of the EVAL-M3-302F evaluation board.

(® é—- ar: @@'@@

e @ o

¢ @ e
q 9 @ o

'® o_-_J]

On-board debugger
USB interface
connector (X101)
MCU core UARTO and
SWD connecter (J3)
MCU core UART1
connecter (J9)
Signal pin (J8)
Signal pin (J6)
IMC302A-F064
iMOTION™ motor
control IC

Signal pin (J7)
Signal pin (J5)

. IMOTION™ link

connector(J4)

. Hall sensor input

connecter (J2)

. IMOTION™ MADK-M3

30-pin interface

connector (J1)

Figure4  Functional groups of the EVAL-M3-302F evaluation board’s top side

5.1 Setting up the motion control engine (MCE)

After downloading and installing the iIMOTION™ PC tools (MCEWizard and MCEDesigner), the following steps
need to be executed in order to run the motor. Refer to Chapters 5.2.1 and 5.2.2 as well as MCEWizard and
MCEDesigner documentation for more information.

1. Getthe latest IMC302A-F064 MCE software package available on www.infineon.com/imotion-software
website.

2. Connect PC-USB connector on the on-board debugger to the PC via USB cable.

3. Connect EVAL-M3-302F M3 30-pin interface connector (J1) to power board (for example EVAL-M3-CM615PN,
see Figure 5).

4. Use MCEWizard to enter the target motor’s system and operating parameters, as well as the hardware
parameters of the evaluation board, which will then be used to calculate controller’s digital parameter set
representing complete motor drive system. First click “Calculate” button on the “Verify & Save Page” and
then save the drive parameter set into your project directory by clicking “Export to Designer file (.txt)”.
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Saved Drive System Parameter File will be later used by the MCEDesigner; refer to Chapter 5.2.1 or
MCEWizard user guide for more details.

5. Connect motor phase outputs to the motor.

6. Connect AC power to power input connector and power on system.

7. Start MCEDesigner tool and open MCEDesigner default configuration file (.irc) for IMC302A-F064 controller
(IMC302A_Vxxx.irc) by clicking “File” > “Open”. IMC302A_Vxxx.irc file is included in “IMC302A-F064 MCE
Software Package” downloaded in step 1.

8. MCEDesigner should automatically connect to the EVAL-M3-302F control board using default COM port
(indicated by green circle next to “COMx Up” status in the bottom frame of the MCEDesigner GUI). If it
cannot establish the connection, change COM port by doing following steps: (“System” window active) >
Preferences > Connection > Connect using (Chose one of the other available COM ports from the drop-down
menu).

9. Incase the IMC302A-F064 IC on the EVAL-M3-302F is empty (not programmed), which will be indicated by
the pop-up window message after connecting to the MCEDesigner, then use following steps to program the
firmware and system parameters into the internal SRAM of iMOTION™ IC: Click “Tools” > “Programmer” and
select “Program Firmware and Parameters.” Browse and select the IMC302A-F064_A_Vxxx.ldf file which was
included in the “IMC302A-F064 MCE Software Package” downloaded in step 1. Then browse and select the
System Drive Parameters .txt file created in step 4. See chapter MCEDesigner setup overview 5.2.2 for more
details.

10. In case the IMC302A-F064 IC firmware has already been loaded, use the following steps to program the
system parameters into the internal SRAM of iIMOTION™ IC: Click “Tools” > “Programmer” and select
“Program Parameters.” Browse and select the System Drive Parameters .txt file created in step 4. See
chapter MCEDesigner setup overview 5.2.2 for more details.

11. Start the motor by clicking the green traffic light button in the control bar.

@ (infineon e : - ) AC Power

< Eval-M3-CHE1SPN - - an Input

PC-USB
Connector

Motor Phase PFC
Outputs Inductor

Figure5 System connection example using EVAL-M3-302F and EVAL-M3-CM615PN
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5.2 iMOTION™ development tools and software

The iIMOTION™ Development Tool installers for MCEDesigner and MCEWizard are available for download via
Infineon iIMOTION™ website (http://www.infineon.com/imotion-software). All supported tools and software
variants are listed there. Please visit this page periodically to check for tool/software updates.

The isolated on-board debugger provides the USB to UART bridge between the PC and the target iMOTION™
device with 1kV DC galvanic isolation between the motor drive system (hot side) and the PC/debugger (cold)
side. The on-board debugger uses the SEGGER J-Link driver for UART communication with IMC302A-F064. The
J-Link driver will be installed during the MCEDesigner installation. In case the driver is not installed properly,
please go to SEGGER J-Link website to download and install the latest J-Link “Software and Documentation
pack for Windows.”

5.2.1 MCEWizard setup overview

After installing the MCEWizard, the shortcut for MCEWizard appears on the Windows desktop. Double click the
shortcut to open the MCEWizard and configure the parameters for evaluation boards or motor. Figure 6 shows
the “Welcome Page” for MCEWizard, where the MADK control board or power board can be selected via the
pull-down list. Infineon continues to release new MADK controller and power boards. Therefore, it could
happen that some of the newest power boards are not pre-configured in the MCEWizard tool and cannot be
selected in the pull-down menu. In that case, the user should select any other power board (as similar as
possible) and follow the MCEWizard setup steps by entering the parameter values that are specific to the
chosen board. Make sure both “I have modified the circuit board” and “Enable advanced question” checkmarks
are selected. Please refer to the User Guide of the corresponding power board for additional information.

After selecting the MADK control and the power board, start the MCEWizard system setup procedure by clicking
the “Next” button in the right bottom corner as shown in Figure 6.

B MCEWizard 2.3.0.0 - C:\Users\gliang1\Documents\EVAL-M3-302F-CM615PN.mc2 - X

File JumptoPage Help

Welcome Page v

iMOTION™ 2.0 System Configuration Wizard

Evaluation board for supporting - 3 e Bl 57 1 D O
customers during their first steps of mfmeon §

designing applications with CIPOSMini
PFC integrated IPM. The combination of

this power board and matching ‘f'-’_’g;q‘_— N
iMOTIONcentrol board EVAL-M3-302F,

based on the IMC302A-F064 iMOTION 1:1

controller, creates a powerful inverter + 4

PFC system for evaluating the latest o :

Infineon technologies.

The Eval-M3-CM615PN features the
IFCM15P60GD, one of the CIPOSMini
product family, which combines a 3-phase
inverter stage with a PFC stage based on
TRENCHSTOPIGBTS.

Get MADK Hardware Info Get iIMOTION™ Info
Save System Configuration File J
Previous Next
Figure6  Welcome Page of MCEWizard
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The iIMOTION™ MADK system enables users to easily test different combinations of control and power boards
with their motors. The user should be familiar with the system-level parameters related to the motor used.
There is a very limited number of parameters that are specific to the control board or power board hardware.
Table 13 provides the MCEWizard setup overview for hardware-related parameters. Similar tables will be
available in the User Guide of the specific power board. Combinations of this table and the corresponding table
of the power board provides sufficient information to set up the MADK-based motor drive system in the
shortest time.

Table 13 MCEWizard setup overview table

Parameter

Value

Comment

Power board selecting

MADK power board name

If no, select similar
power board to modify

Motor 1 shunt configuration

Refer to the power board App Note

Controller supply voltage

Refer to the power board App Note

VDD is 3.3V by default

Max DC bus voltage

Refer to the power board App Note

DC bus sensing high resistor

Refer to the power board App Note

DC bus sensing low resistor

13.3kOhm

NTC temperature shutdown
value

Calculated as in Section 6.3.2

Refer to the power
board App Note

GateSense Low-Side devices

Refer to the power board App Note

High is true by default

GateSense High-Side devices

Refer to the power board App Note

High is true by default

Motor 1 current input

Calculated as in Section 6.1.2

PFC topology

Refer to the power board App Note

Boost or totem-pole

PFC current input

Calculated as in Section 6.2.2

PFC gate driver polarity high
side

Refer to the power board App Note

High is true by default

PFC gate driver polarity low
side

Refer to the power board App Note

High is true by default
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After all the MCEWizard questions are answered, the “Verify & Save Page” will be shown as in Figure 7.

MCEWizard 2.3.0.0 - Infineon Technologies e @) X

File JumpPageTo Help

|Verify & Save Page -

Verify Parameters

Calculate Pala'metefs_‘ Display Parameters Results Export to MCEDesigner File ('.ka}|

Double-Click an item to JUMP to its associated question

| Previous | | Nex |

Figure7  Verify and Save page for MCEWizard

Click “Calculate” button and “Export to Designer File (.txt)” button to save the parameter file that will be used
by the MCEDesigner in the next steps.

5.2.2 MCEDesigner setup overview

After installing the MCEDesigner installer, there is a shortcut for MCEDesigner on Windows desktop. Double-
click on the shortcut to open MCEDesigner and then open “IMC302A_xx.irc” file (which was included in the
“IMC302A-F064 MCE Software Package” installed earlier, as instructed in Chapter 5.1) shown in Figure 8.

S PFC - MAC302T_V1,02.21 ire - MCEDesignes Ver 2. .00 - Infineon Technelogies
Fie Niew Preferences Tock Winden Help
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5 [ MotarSpeed &TargetSpeec | = B Configure PFC

& Bl st = [ st PFC

I & Sow & W stopprC

el ar - Emergancy Stop - Emergency Stop

= B O &P 5 B Configure Motor = B Dvive Saatus

& [ lu & Motorspeed ] B Vessaasznnsansrant
E @ uaTg & B ClearFault

o [ Status & Spd /Trg. 1 B Change Target Voliage
B Status &l @ B V¥ Disgnostic & B Control Tune

) Phusingle & SpdEr - I Resd DC Ushage Count - Curent Loop Tune:
@ d&lg - Current Loop Tune - VoRage Loop Tune.

o B A B AR = [ Speed Loop Tune = I Read M5 Count
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& @ et aia 5 M Subfunction Libeary Definition

[ PRC Vac & lpfc
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& D PFC et Bloeg ’
5 8 PFC AbetiacRow & Ipfc = 48 Sublunction Library Definition 1
e I PFC AbeVacRaw & Cument = B Register Structure Defintions
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5 I PFC Abe¥ac & PFC DK
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e I PFC Absiac & DutyCyoted
5 [0 PFC Vac & VACpK

& (B Fluxingle & Hallangle |
£ I HallAnge & ATanAngle
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< > < s < >

For Help, press FI Imicioa (e comi7Up [Tigidle | Motorl Stop | prcStmp & Systemis On )

Figure8 MCEDesigner’s main display for EVAL-M3-302F
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MCEDesigner programmer function can be used to program IMC302A-F064 firmware and/or system parameters.
To call up this function, click on “Tools” menu and then select “Programmer” in the pull-down list. The pop-up
window “Program IMC controller” will show up asin Figure 9.

To program both firmware and drive system parameters into IMC302A-F064 (which can happen when
programming the brand new devices with default factory settings for the first time, or when the new version of
iMOTION™ firmware is being downloaded), first click on the “Program Firmware and Parameter” radio button in
the “Program IMC controller” pop-up window. After that, select the “Drive System Parameter” file created using
MCEWizard by clicking on the “Browse...” button at the end of the “Program Parameter File” row, and then also
select the IMC302A-F064_A_Vxxx.ldf file (which was included in the “IMC302A-F064 MCE Software Package”) by
clicking on the “Browse...” button at the end of “Program Firmware File” row. Finally, click on the “Start”
button to program the parameter file into the IMC302A-F064 IC.

-]
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For Help, press £ T8 & COWEDLL Using Tng Idi= @ Mstor inacive | [® BFCinoctve @ Symemizdn

Figure 9 Program firmware and parameters in “Program IMC Controller” pop-up window

To program only “Drive System Parameter” file into IMC302A-F064, click on “Tools” menu and select
“Programmer” in the pull-down list. The pop-up window “Program IMC controller” will show up as in Figure 10.
Click on the “Program Parameters” button (this is the default option), and then select the “Drive System
Parameter” file created using MCEWizard by clicking on “Browse...”. Finally, click on the “Start” button to
program the parameter file into the IMC302A-F064 IC.
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Figure10 “Program IMC Controller” pop-up window

After “Drive System Parameter” file has been programmed into IMC302A controller, and the motor drive system
is powered, the MCEDesigner can be used to start/stop the motor, display motor current traces, change the
motor speed, modify drive parameters, and many other functions. Please refer to the MCEDesigner
documentation for more details.

Note: The on-board debugger section of EVAL-M3-302F is galvanically isolated from the controller
section and the attached power board. In order to program the parameters or firmware to the
IMC302A-F064 controller, the 3.3 V DC voltage needs to be supplied to the controller portion of the
EVAL-M3-302F. This voltage can either be supplied by the power board (MADK power boards are
designed to supply the 3.3 V to the control board through M1 or M3 connector) or by feeding the 3.3
V DC voltage to the control board through some of the available 3.3 V access/test points, if the
power board is not attached to the EVAL-M3-302F control board.

All the latest firmware files for different types of iIMOTION™ control ICs are available for download via Infineon
iMOTION™website (http://www.infineon.com/imotion-software).

5.3 Working with the MCU

The microcontroller in the IMC302A-F064 is based on an Arm® Cortex® MO core allowing the use of a wide range
of development tools and available software solutions.

Connection to the MCU is offered via the standard serial wire debug (SWD). The SWD interface is routed via the
galvanic isolation to the on-board interface. The debug interface is based on Segger® J-Link technology. The
respective DLL is installed on the PC during installation of the above-mentioned iMOTION tools, namely the
MCEDesigner. Alternatively, the installation of the respective driver can be updated from the Segger website.

Configuring, setting up and programming the embedded MCU is beyond the scope of this User Guide. Please
refer to the Hardware Reference Manual of the IMC300 series and the CMSIS pack.
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6 Hardware description of EVAL-M3-302F

This chapter covers the hardware design of the EVAL-M3-302F in more detail. To enable users to make the EVAL-
M3-302F evaluation board a basis for a new development or modification of their own systems, all necessary
technical data such as schematics, layout and components are also included in this chapter.

6.1 Motor current feedback circuitry

6.1.1 Motor shunt configuration

Both single shunt and leg shunt topologies are supported by the EVAL-M3-302F control board. The user needs
to ensure that the shunt configuration matches the power board hardware configuration. Please refer to the
power board User Guide for details. The shunt configuration can be changed in MCEWizard by clicking and
selecting in the pull-down list marked with a red box as shown in Figure 11.

£ MCEWizard 2.3.0.0 - C\Users\gliang1\Documents\EVAL-M3-302F-CM&15PM.mec2 - *

File JumptoPage Help

Options Page -

Basic System Configuration Options

iMOTION™ Device Configuration Options Application Configuration Options
Product Family: MC302A  system Info: | EVAL-M3-IMC302A+EVAL-M3-CMB15PN |
Controller Device Package: LQFP-64 ~
< _ Firmware Version Select:

Motor 1 PWM Frequency |:| Kitz Script Function Enable/Disable:
Mator Fast Control Rate:

Application Control Interface: UART ~
PFC PWM Frequency: KHz

Motor Control Options
Hardware Current Sensing Configuration Options

Motor Control Mode: Speed Control ~
Motor Current Shunt Configuration: Single Shunt ~ Rotor Angle Calculation Method: Flux PLL Angle ~

System Load Monitor
Hall Sensor Configuration: None Hall ~ ¥
Total CPU Load: _ 65% usage

Previous MNext

Figure 11 Shunt configuration

6.1.2 Motor external current feedback configuration and calculation

The shunt resistance Rq, value can be found in the schematics or User Guide for the power board (for example,
the leg shunt resistors are 30 mQ for EVAL-M3-CM615PN and 100 mQ for EVAL-M3-TS6-606).
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The current input value is a product of the shunt resistance in milliohms and gain of external current sense
amplifier as shown in Figure 12.

Current Input
(mv/a)

Figure12 Current shunt feedback and sample timing

Figure 13 depicts IU+ current feedback sensing circuity on EVAL-M3-302F evaluation board. Please note that the
default external amplification gain is less than 1 for current sense in this evaluation board.

Current shunt on|
power board

IMC302A

U

Figure 13 The current feedback section on the EVAL-M3-302F evaluation board

Based on the principle of Kirchhoff's voltage law,

V2 ~ Vl ~ (VDD — Igp * Rsh) * R23 + Ish * Rsh = R23 VDD + R22 Rsh * Igp
Ry; + Ry3 Ry, + Ry3 Ry, + Ry3
C t input Rz p > R
urrent input = ————— =—
inp Ry, + Rys sh 6 sh

Based on this calculation, and the Ry, in EVAL-M3-CM615PN is 30 mQ, the current input for the MADK
combination of EVAL-M3-302F and EVAL-M3-CM615PN is 25 mV/A. Please use same procedure to calculate the
current input for other combinations of MADK boards and enter it into MCEWizard.
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Figure 14 Current feedback configuration in MCEWizard for EVAL-M3-302F and EVAL-M3-CM615PN

6.1.3 Internal amplifier gain configuration

For the current feedback, the iIMOTION™ controller on this board has the internal amplifier which has four

programmable gain settings: 1x, 3x, 6x and 12x.

The internal current-feedback amplifier gain can be configured in MCEWizard as shown in Figure 15.

g MCEWizard 2.3.0.0 - C:\Users\gliang 1\Documents\EVAL-M3-302F-CMB15PN.mc2

File JumptoPage Help

Motor 1 Current Feedback and Sample Timing
Question 84 - Internal Current Feedback Amplifier Gain

Question 84 : Motor 1 Current Feedback and Sample Timing - Internal Current Feedback Amplifier Gain
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This parameter is the gain set for the programmable gain
amplifier between the current sense pin and the ADC,

This parameter is the gain set for the programmable gain
amplifier between the current sense pin and the ADC.

The available gain values are 1, 3, 6 and 12. The net gain
provided by the internal and external amplifiers determines the
current feedback range: I_range = (VDD/2)/(G_int X G_ext X
R_3)

The product of the gain and the voltage offset (V_off) should be
50% of VDD to ensure current sensing is centered around zero.

wRn o
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Figure 15 Internal current-feedback amplifier-gain configuration
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6.2 PFC hardware configuration

6.2.1 PFC topology selection

The EVAL-M3-302F control board applies to both PFC algorithms, boost mode and totem pole. The user needs
to ensure that the topology configuration matches the power board hardware configuration. The topology
configuration can be changed in MCEWizard as shown in Figure 16.

EJ MCEWizard 2.2.00 - G\Users\gliangT\Documenl Es\EVAL-M3-302F-CMB15PMN.mc2 - b

File JumptoPage Help
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PFC Hardware
Question 107 - PFC Topology Expand Ficture

Specify PFC topology, Boost or Totem-Pole.

Tatem-Pole PFC

Answer: Boost V!

Pravious Next

Figure 16 The PFC topology selection in MCEWizard for EVAL-M3-302F and EVAL-M3-CM615PN

6.2.2 PFC external current feedback configuration and calculation

Please refer to the schematic diagram of the power board for the shunt resistance value (for example, the shunt
resistors are 30 mQ for EVAL-M3-CM615PN and 100 mQ for EVAL-M3-TS6-606).

The current input value is a product of the shunt resistance in milliohms and gain of external current sense
amplifier as shown in Figure 17.

el .
~T S
Current
Input
(mV/A)
Figure 17 PFC current shunt feedback and sample timing
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6.2.3 PFC current feedback configuration

Figure 18 depicts IPFC- current feedback sensing circuity on EVAL-M3-302F evaluation board. Please note that
the default external amplification gain is less than 1 for current sense in this evaluation board.

133V
[PFC- V4 IPFC :
. A IPFC
: e
: 102
]
P < IMC302A
R34
12k, 1%
L AN—— AA—PECTRIP IrpperTRIP
R35.  R36 ——(25
1k, 1% . 1k, 1% 271

Figure 18 The PFC current feedback circuit for EVAL-M3-302F evaluation board

Based on the principle of Kirchhoff's voltage law,

Vo~ Vo~ (Vpp + I * Rep) 0% [ Ry = -0y R0 g
Ri7 + Ryg Ri7 + Ryg Ri7 + Ryg
C t input R o _12p
urrent input = ————— = —

Based on this calculation, and the Ry, in EVAL-M3-CM615PN is 30 mQ, the current input for the MADK
combination of EVAL-M3-302F and EVAL-M3-CM615PN is 27.69 mV/A. Please use the same procedure to
calculate the current input for other combinations of MADK boards, and enter it into MCEWizard.

IMC302A
IPFCREF
[PFCREF
C21
470R; 1% > -

—T 472

Figure 19 The PFCTRIPREF circuit on the EVAL-M3-302F evaluation board

The PFC’s overcurrent protection circuit is shown in Figure 18 and Figure 19.
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The calculation formula for the threshold is as follows,

. _y ( R9 R25 ) R25+R6 1
PFCTRIP — "DD \pg + R9  R25 + R6 R25  Rsh

6.2.4 AC voltage-sensing configuration

Figure 20 shows the schematic of EVAL-M3-302F evaluation board with VAC sense.

B ;. (VN G— V) Vo
AC Voltage sensing input2. >R24 | o
15k, 1% —T1—
AC Voltage sensing mmputl »>R28 T C20
= | an

Figure 20 The AC voltage-sensing schematic

There are two AC voltage sensing inputs in differential mode. The high-side resistor for the AC voltage-sensing
resistor divider on the power board EVAL-M3-CM615PN is 2000 kQ, and should be configured in MCEWizard as
shown in Error! Reference source not found..

g MCEWizard 2.3.0.0 - Ch\Users\gliang1\Documents\EVAL-M3-302F-CME15PM.mec2 = >

File JumptePage Help

Question 114 : PFC Hardware - AC Voltage Sensing High Resistor -

PFC Hardware
Question 114 - AC Voltage Sensing High Resistor Expand Picture

Normally a resistor divider is used for AC voltage sensing.
Please specify the high resistor value.

50 that the internal voltage scaling can be calculated based on

attenuation of resistor divider. AC Voltage

High
Resistor

To ADC
Low
Resistor
Answer: ZDDD! KOhms
Previous Mext
Figure 21 AC voltage-sensing configuration in MCEWizard 1
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The low-side resistor R11 or R16 for the AC voltage-sensing resistor divider on the controller board EVAL-M3-
302F is 15 kQ, and should be configured in MCEWizard as shown in Figure 22. For the high-side resistor value,
please refer to the User Guide of the corresponding power board.

(&) Infineon Technologies - MCEWizard 2.0.0.20 =B R
[Question 91 : PFC Hardware - AC Voltage Sensing Low Resistor - |
PFC Hardware
Question 91 - AC Voltage Sensing Low Resistor \Flpﬁﬂd F'icmrF-'|
Normally a resistor divider is used for AC voltage sensing.
Flease specify the low resistor value
so that the internal voltage scaling can be calculated based on
attenuation of resistor divider. AC Voltage
High
¥ Resistor
[ To ADC
2z Low
% Resistor
Answer: 15 KOhms
| Previous | Next
Figure 22 AC voltage sensing configuration in MCEWizard 2
. . .
6.3 EVAL-M3-302F analog inputs and their MCEWizard setup

Besides current-sensing inputs, IMC302A-F064 provides a number of analog inputs for different system
functions. Figure 23 depicts the analog inputs of the IMC302A-F064 except for the current-sensing inputs.

+3.3V
R20
487K, 1% | pp
External Temerature Sensing mput | VTH > : NTC
1 c12
T 103
IMC302A
DC Bus Voltage Sensing input DCBSENSE —# DCBRENSE VDC
é[{zl _.[_(71/1
{133k 1% | 172
Figure 23 Analog inputs on the EVAL-M3-302F evaluation board
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6.3.1 DC bus-sensing configuration

The low-side resistor R4 for the DC bus-sensing resistor divider on the controller board EVAL-M3-302F is 13.3 kQ,
and should be configured in MCEWizard as shown in Figure 24. For the high-side resistor value, please refer to
the User Guide of the corresponding power board.

Q MCEWizard 2.3.0.0 - C:\Users\gliang 1\ Documents\EVAL-M3-302F-CME15PN.mc2 — >

File JumptoPage Help

Question 51 : System DC Bus - DC Bus Sensing Low Resistor -

System DC Bus

Question 51 - DC Bus Sensing Low Resistor Expand Picture
Typically, a resistor divider is used for the DC Bus voltage
sensing. Please specify the low resistor value, so that the
internal voltage scaling can be calculated based on the
attenuation of the resistor divider. DC bus
Warning: Incorrect resistor values may lead failure of the & High
voltage protection functions and unsafe operation of the drive. 'y s > Hosistor
o—
==
O il 2 s To VDC
A A < Low
:l' Resistor
Answer: i 13.3| KOhms
Previous Next
Figure 24 DC bus-sensing configuration in MCEWizard
. . .
6.3.2 NTC shutdown value calculation and configuration

External NTC temperature shutdown values can be calculated as shown below and configured in MCEWizard as
shown in Figure 25. For the pull-up resistor on the evaluation power board and the NTC value, please refer to
the power board’s User Guide. The value of the pull-up resistor on EVAL-M3-302F is 4.87 kQ (see Figure 23).

Rpull—up on Control board * Rpull—up on Power board

Riotar =
pull-up
Rpull—up on Control board + Rpull—up on Power board

RNTC@setting temperature

Vshut down = Vbp

RNTC@setting temperature + Rtotal pull-up

For example, for EVAL-M3-CM615PN, the pull-up resistor on the power board is 9.1 kQ. So the total pull-up
resistance calculates to be 3.172 kQ.
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The typical value of Ryrc at 100°C is 5.388 kQ for the IPM IFCM15P60GD that is used in EVAL-M3-CM615PN. If the
setting temperature is 100°C, the shutdown value should be 2.08 V.

g MCEWizard 2.3.00 - Ch\Users\gliang 1\ Documents\EVAL-M3-302F-CME15PM.mc2 5 X

File Jumpto Page Help

Question 72 : Motor 1 Fault Conditions - NTC Over-temperature Voltage Threshold -

Motor 1 Fault Conditions

Question 72 - NTC Over-temperature Voltage Threshold Expand Picture
This parameter sets the threshold level for Over Temperature
Shutdewn. I b Motor current Limit o
oT Shutd
If the Over Temperature Shutdown is enabled, a fault is k-—-—'/ . e
detected when the voltage at NTC input pin falls below the NTC <
Over-temperature Voltage Threshold Level. i
Motor Temperatue Limit
T e
\_/ o 0
r/_h »
1
(T, S
NTC Voltage Threshols ™~ | __—
{
Answer: 208 v
Previous Hext

Figure 25 External temperature-sensing input configuration in MCEWizard
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6.4 Schematics overview

Figure 26 shows the schematic of EVAL-M3-302F evaluation board with IMC302A-F064 controller.
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Figure26 The schematics of the EVAL-M3-302F evaluation board

6.5 PCB layout overview

The layout of this board can be used for different voltages or power classes of the power board. The PCB has
two electrical layers with 35 pm copper by default, and its size is 65 mm x 45 mm. The PCB board thickness is
1.6 mm. Check Infineon’s website or get in contact with Infineon’s technical support team to obtain more
detailed information and the latest Gerber files.
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Figure 27 illustrates the top assembly print and top paste layers of the evaluation board.
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Figure 27 Top overlay print of the EVAL-M3-302F evaluation board

Figure 28 depicts the bottom assembly print of the evaluation board.
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Figure 28 Bottom overlay print of the EVAL-M3-302F evaluation board
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Bill of materials

Table 14 provides the complete bill of materials for the EVAL-M3-302F board.

Table 14 Bill of materials
No. | Qty. | Part description Designator | Part Number Manufacturer
1 1 CAP SMD 10uF 16V 0805 C1 885012206014 Wurth Electronics Inc.
2 11 CAP SMD 0.1uF 16V 0603 C2, C11, 885012206004 Wurth Electronics Inc.
C13, C23,
C101, C102,
C103, C104,
C108, C110,
Ci11
3 3 CAP SMD 10nF 16V 0603 C3,C12, 885012206010 Wurth Electronics Inc.
C16
4 2 CAP SMD 1uF 16V 0603 C4,C17 885012206003 Wurth Electronics Inc.
5 9 CAP SMD 4.7nF 16V 0603 C5, C6, C7, | 885012206012 Wurth Electronics Inc.
C8, C14,
C18, C20,
C21,C24
6 4 CAP SMD 220pF 16V 0603 C9, C15, 885012206020 Wurth Electronics Inc.
C19, C22
7 1 CAP SMD 2.2nF 16V 0603 C10 885012206012 Wurth Electronics Inc.
8 2 CAP SMD 10uF 6.3V 0603 C105, C115 | 885012206014 Wurth Electronics Inc.
9 2 CAP SMD 15pF 16V 0603 C106, C107 | 885012206020 Wurth Electronics Inc.
10 |2 CAP SMD 1uF 16V 0603 C109, C113 | 885012206003 Wurth Electronics Inc.
11 |1 CAP SMD 4.7uF 16V 0603 Cl12 885012206012 Wurth Electronics Inc.
12 |1 CAP SMD 10uF 10V 0805 Cl14 885012206014 Wurth Electronics Inc.
13 |9 RES SMD 1/10W O0ohm 0603 R1, R2, R3, | RCO603JR-07
R32, R33,
R113, R114,
R115, R116
14 |3 RES SMD 1/10W 1Kohm 0603 R4, R5, R6 | RCO603JR-071KL
15 |6 RES SMD 1/10W 2Kohm 0603 R7,R9, R11, | RCO603JR-072KL
R13, R16,
R103
16 |4 RES SMD 1/10W Oohm/DNI 0603 | R8, R10, RC0603JR-07
R12, R14
17 |2 RES SMD 1/10W 9.1Kohm 0603 R15, R101 | RC0O603JR-079K1L
18 |4 RES SMD 1/10W 10Kohm 0603 1% | R17, R22, RC0O603FR-0710KL
R25, R30
19 |4 RES SMD 1/10W 2Kohm 0603 1% | R18, R23, RC0O603FR-072KL
R26, R31
20 |1 RES SMD 1/10W 1Kohm 0603 1% | R19 RC0O603FR-071KL
21 |1 RES SMD 1/10W 4.87Kohm 0603 | R20 RC0O603FR-074K87L
1%
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No. | Qty. | Part description Designator | Part Number Manufacturer
22 |1 RES SMD 1/10W 13.3Kohm 0603 | R21 RCO603FR-0713K3L
1%
23 |2 RES SMD 1/10W 15Kohm 0603 1% | R24, R28 RCO603FR-0715KL
24 |1 RES SMD 1/10W 24Kohm 0603 1% | R27 RCO603FR-0724KL
25 |1 RES SMD 1/10W 470o0hm 0603 1% | R29 RC0603FR-07470RL
26 |1 RES SMD 1/10W 3Kohm 0603 R102 RC0603JR-073KL
27 |2 RES SMD 1/10W 33ohm 0603 R104, R106 | RCO603JR-0733RL
28 |1 RES SMD 1/10W 5100hm 0603 R105 RC0603JR-07510RL
29 |2 RES SMD 1/10W 4.7Kohm 0603 R107, R111 | RCO603JR-074K7L
30 |2 RES SMD 1/10W 10Kohm 0603 R108, R110 | RCO603JR-0710KL
31 |1 RES SMD 1/10W 1Mohm 0603 R109 RC0603JR-071ML
32 |1 RES SMD 1/10W DNI 0603 R112 RC0O603JR-07
33 |1 CONN HEADER DUAL 30POSRA |]1 61303021021
254
34 |1 CONN HEADER VERT SING 6POS | ]2 61300611121
2.54
35 |2 CONN HEADER VERT DUAL 8POS |]3,J4 61300821121
2.54
36 |2 CONN HEADER VERT DUAL J5,]6 61301021111
10POS 1.27
37 |2 CONN HEADER VERT DUAL 4POS | J7, 18 61300421111
1.27
38 |1 CONN HEADER VERT DUAL 4POS |19 61300421121
2.54
39 |1 FERRITE BEAD 60ohm 0603 1LN L101 BLM18PG600
40 LED GREEN CLEAR 0603 SMD LED1, 150060GS75000 Wurth Electronics Inc.
LED102
41 |2 LED RED CLEAR 0603 SMD LED2, 150060RS75000 Wurth Electronics Inc.
LED101
42 LED BLUE CLEAR 0603 SMD LED103 150060BS75000 Wurth Electronics Inc.
43 |1 OSC 12.0000MHz SMD Q101 12MHz/S/3.2X2.5
44 |12 TEST POINT PC MINI .040"D TP1,TP2,TP | 5001
BLACK 3, TP4,TP5T
P6,TP7,TPS,
TP9,TP10,T
P11,TP12
45 |1 IC MCU 32BIT 128KB FLASH Ul IMC302A-F064 Infineon Technology
LQFP64
46 |1 IC MCU 32BIT 256KB FLASH U101 XMC4200_QFN48 Infineon Technology
48VQFN
47 |1 IC REG LINEAR 3.3V 1A SOT223-4 | U102 IFX1117-ME V33 Infineon Technology
48 |1 DGTL ISO 3.75KV GEN PURP SO- | U103 SiB662EC-B-1S1
16-NB
49 |1 IC BUFF TSSOP5 U104 74LVC1G126GW
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No. | Qty. | Part description Designator | Part Number Manufacturer
50 |2 TVS DIODE 17VC WLL-2-1 V101, V102 | ESD237-B1-W0201 | Infineon Technology
51 |1 DIODE SCHOTTKY 30V 1A V103 BAS3010A-03W Infineon Technology
SOD323-2
52 |1 CONN RCPT MICRO USB AB SMD | X101 ZX62-AB-5PA
R/A
53 |1 CONN HEADER VERT SING 5POS | X102 61300521121
2.54
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8 Reference

[1]  Infineon-IMC300_series-DataSheet-v01_00-EN.pdf
[2] iMOTION™ MCE Software Reference Manual

[3] MCEWizard User Guide

[4] MCEDesigner User Guide

Note: All listed reference materials are available for download on Infineon’s website
www.infineon.com/imotion. All User Guides of the iMOTION™ MADK power boards are available at
www.infineon.com/MADK

Notice:

Infineon’s product registration is now online. You can register your board online, and download additional
information.

There are three easy steps to register:

1. Go to www.Infineon.com/ login to myinfineon

2. Click on “Product Registration”

3. Choose your board, and enter board series number, then download the related information package
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